
chapter 5
Digital Media and
DVD on Windows

AS DESCRIBED IN THE PRECEDING CHAPTER, Apple has refocused its Macintosh
product line to provide built-in support for digital media right out of the box,
including the necessary hardware ports and disc drives, and associated software-
editing tools. As you will see in this chapter, Microsoft is moving in a similar direc-
tion with Windows XP, but the picture for the PC and Windows world is more
complicated. There are wide variations in the hardware capabilities of different
computer systems, differences in the digital media support built into various ver-
sions of the Windows operating system, and more use of third-party tools that
also differ between systems.

This chapter discusses digital media under Windows XP, which has become a
complete environment for acquiring, viewing, and editing digital media. You can
transfer photos from a digital camera through a USB port, and capture digital
video and audio from a DV camcorder through a FireWire/IEEE 1394 connection.
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114 PART I Understanding DVD: Consumer and Computer

Of course, you also can import media from other sources, such as scanners and
analog capture devices, as well as download and transfer materials over the
Internet. Many of the issues in this discussion (and certainly the general concepts)
also apply to earlier versions of Windows—especially Windows 2000 and
Windows ME for the home.

Even as most PCs were shipping in 2002 with Windows XP, however, it is still possi-
ble to purchase a Windows computer with limited digital media capability, such as
only a CD-ROM reader, and therefore with no capability to read DVDs or write
CDs or DVDs. When you buy a Windows computer for digital media, make sure
you get the appropriate digital media hardware and software components, as shown
in Table 5.1. If you purchase a Windows XP computer with these components pre-
installed, the vendor also should install all the associated drivers and utility software.

TABLE 5.1 Suggested Hardware for Digital Media Under Windows XP

USB/USB-2 port Universal Serial Bus that is standard on most current
Windows computers. A standard interface for connect-
ing to peripherals at moderate speeds (12Mbits/sec).
Used for transferring digital photos from a digital cam-
era. Also used to reduce wires, to replace the serial and
parallel ports by chaining together the keyboard and
mouse, and for devices, such as printers and scanners.
The new USB-2 port that started appearing in mid-2002
offers higher-speed connections for external devices,
including hard disk drives and DVD drives.  

FireWire/IEEE-1394 port Added cost option for most Windows computers. A
standard interface for connecting to peripherals that
require higher speed (400Mbits/sec). Used for transfer-
ring digital video from a DV camcorder. Also used for
connecting to external drives, such as DVD recorders
and hard disks.  

CD-R/RW drive Read/write CD drive (Recordable and ReWritable). 
Still an added cost option on many Windows computers,
but becoming standard.  

DVD-ROM drive Read-only DVD drive. Reads data and video DVDs, and
typically also CDs. Still an added cost option on many
Windows computers, but becoming standard.  

DVD-R or DVD-RW drive Read/write DVD drive (Recordable/ReWritable). There
are multiple competing and incompatible standards for
recordable DVD drives. Reads data and video DVDs,
and sometimes also records CDs. Added cost option
that is becoming more available on Windows computers. 
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This chapter explores Windows XP as a platform for digital media, including burn-
ing data to recordable CD and DVD drives, acquiring and organizing digital photos
in the My Pictures folder, and importing motion video and editing movies with
Windows Movie Maker. Chapter 7, “Playing DVDs in Windows XP,” describes
how to use Windows Media Player to organize and play music and videos,
especially audio CDs and movies on DVD.

Using these tools, you can acquire and prepare the materials that you then can
import into the DVD authoring tools described in the following parts of the book.
These materials include video clips, additional audio tracks, still image backgrounds
for menus, and even photo slide shows.

Burning Data to CD and DVD
Although we think of CD and DVD discs in terms of music and movies, a comput-
er sees these discs as just another digital data storage device. The disc contents
may be audio or video, but it is all just data to the computer. A computer with a
recordable CD or DVD drive can write any type of data to the CD or DVD—not
just music or video. Hence, you can use recordable CDs and DVDs to back up,
archive, or share files. A CD holds 650 to 700MB of data, and a DVD holds 
about 4.7GB.

T I P

Originally, the CD data recording applications described worked only with CDs, not with
DVDs, so writing DVDs required different tools. More recently, the built-in support in
Windows XP and in these applications has been expanded to supporting both CDs and
DVDs. However, many of the application dialog boxes and explanatory language still refer
only to CD, not to DVD. This chapter generally refers to both, with some differences
between the way recordable and rewritable drives work.

Windows XP Desktop CD and DVD Recording
Windows XP now includes the capability to burn data to a CD or DVD directly
from the desktop by copying files to the CD or DVD drive in Windows Explorer.
Windows actually builds a temporary disc image file with the files that you have
copied. When you have accumulated all the files you want to record, you then
start the process of burning the data to disc. This works much like desktop CD
burning on the Macintosh, as described in Chapter 4, “Digital Media and DVD on
the Macintosh.”
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In addition, many Windows systems also ship with third-party CD burning 
tools, such as Roxio (formerly Adaptec) Easy CD Creator and Direct CD
(www.roxio.com). Easy CD Creator allows you to create Audio CDs, and to
organize data files and folders to be burned to a data CD and then burn the
entire set in one operation. DirectCD adds itself to the Windows file system
to allow you to drag and drop files to a CD as if it were a hard disc, so it writes
out small packets of data continuously as you add items to the disc.

However, using both the Windows XP desktop CD recording feature and
DirectCD at the same time can be confusing. Instead, you can disable the
Windows recording feature, or you might find that it is already disabled on 
some systems when DirectCD is installed. To check your system, open My
Computer to see your disk drives, click to select the recordable CD (or DVD)
drive icon, and right-click and choose Properties from the pop-up dialog box.

In the CD Properties dialog box, click on the Recording tab (see Figure 5.1). To
disable Windows desktop CD recording, uncheck Enable CD Recording on This
Drive. (If DirectCD has been installed, the Recording tab might be removed, and
new Settings and DirectCD Options tabs are added instead.)

FIGURE 5.1

Use the Recording tab
in the CD Properties
dialog box to control

Windows desktop CD
recording.
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Choosing Recordable Disc Formats
Before you burn data to a CD, it must be formatted or prepared for adding direc-
tories and files. Blank discs that you buy in the store are unformatted. For CD-R
(Recordable) write-once discs, you format them once and then can burn one or
more groups of data until the disc is full. For CD-RW (ReWritable) discs, you can
format and write to them like a CD-R, and reformat them to erase their contents
before using them again. 

CDs can be formatted to several different standards, depending on the intended
use and the need to be compatible with older platforms and players. These include
the following:

• CD-Audio

• UDF 1.5, the new universal disc format

• High Sierra IS0 9660, the Windows standard for CD-ROM

• Macintosh HFS

These standards define the file system used to organize data files on the disc,
including whether the files can have long names or must comply to the 8.3 (eight-
letter filename and three-letter file type) convention of the original DOS. For the
most part, you can ignore these details and accept the appropriate format used by
the disc-burning tools. Just be aware that after a disc is formatted for a particular
purpose to an audio or data format, you cannot combine a different format on the
same disc.

After you burn data to a CD disc, you can leave the disc in one of two states:
open or closed. If you expect to add more data to the disc, you can leave it open
for further writing. If you are done writing data and want to read the disc on
another drive, then you should close or finalize the disc to mark it as complete.
Many audio CD players can only read discs that have been closed.

Formatting Recordable Discs
Although you must format a recordable (R) disc before you write data to it, this
formatting process is often combined with the burning operation. Therefore, you
typically do not need to perform a separate formatting operation when a blank
disc is inserted in the computer. 
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ReWritable (RW) discs can be reformatted to erase data stored on them and pre-
pare them to be reused. You can do this by right-clicking on the disc icon in Explorer
and selecting Format, or by using Easy CD Creator to pull down the CD menu and
choose Erase (see Figure 5.2). Use the DirectCD Format dialog box to prepare a
disc for use with DirectCD (see the section, “Writing FIles with DirectCD,” later in
this chapter for more information). Use Quick Erase to prepare the disc to be
reused, or Full Erase to actually erase the entire contents of the disc.

Burning Data Discs with Windows 
Desktop Recording
To burn data to recordable CDs or DVDs on the Windows desktop, first copy the
files to the CD disc icon and then start the burning process. 

You can copy files by dragging and dropping them to the disc icon, or by using
Copy from the menus. You also can select the files in an Explorer window and
then click on Copy on the Explorer task pane. Windows displays the Copy Items
dialog box, so you can choose the destination recordable disc device. 

Windows then builds a temporary image file of the data to be written to CD.
Open the CD drive in Windows Explorer to view the files and folders that are
ready to burn (see Figure 5.3).

FIGURE 5.2

Use Easy CD Creator
to reformat a 

CD-RW or DVD-RW
ReWritable disc.
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Finally, click on Write These Files to CD in the Explorer task pane. Windows then
displays the CD Writing Wizard to step through the process of burning the data
to CD (see Figure 5.4).

FIGURE 5.3

Use Windows
Explorer to assemble
the files to copy to a
CD or DVD.

FIGURE 5.4

Then, use the CD
Writing Wizard to
write the files to CD.

T I P

In Windows Explorer, click on the Folders button to alternate the left Explorer Bar panel
between a hierarchical list of folders and a context-sensitive Taskbar. The Taskbar dis-
plays appropriate actions for files and folders, depending on their type. Use the View
menu (or Views icon drop-down menu) to choose different views for the list of files in the
right pane.
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Setting the Disc AutoPlay Option
When Windows notices that you have inserted a new disc in a CD or DVD drive,
it examines the contents of the disc. It then can automatically perform a specified
AutoPlay function based on the type of data, such as launching Windows Media
Player to play an audio CD.

To set the default action when a blank disc is inserted, right-click on the CD or
DVD disc icon in Windows Explorer, and choose Properties from the pop-up
menu. In the Properties dialog box, select the AutoPlay tab and then choose Blank
CD from the drop-down list (see Figure 5.5). 

You can than select an AutoPlay option, such as automatically launching Roxio Easy
CD Creator to create a new data CD. You can choose to have Windows prompt
for an action each time you insert a blank disc, or choose Take No Action so that
you can launch the desired application directly.

The AutoPlay option actually launches the Easy CD Creator Project Selector when
you insert a blank disc (see Figure 5.6). Use the Project Selector to choose the
operation to perform with this disc: creating an audio or MP3 CD, creating a data
CD or DVD with Easy CD Creator or DirectCD, creating a photo or video CD,
or copying an existing disc. 

FIGURE 5.5

Use the AutoPlay
options in the CD

Properties dialog box
to set the action to
be performed when

a blank disc is insert-
ed in your system.
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The basic version of Easy CD Creator that is bundled with many new systems
does not have all the options for music and photos. You can upgrade to the
Platinum version to enable all the functionality.

FIGURE 5.6

Use the Easy CD
Creator Project
Selector to begin 
a project with a
blank disc.

Burning Data Discs with Easy CD Creator
To create a data CD or DVD, choose Data Project from the Project Selector, or
launch Easy CD Creator directly (see Figure 5.7). Use the bottom pane of the Easy
CD Creator window to organize the data that you want to burn to disc. You can drag
and drop folders and files from the top pane, and create new folders and reorganize
the folder hierarchy in the bottom pane. Watch the Project Size bar at the bottom of
the window to ensure that the files that you have selected will fit on the disc.

FIGURE 5.7

Use Roxio Easy CD
Creator to organize
files and folders to
burn to a data CD 
or DVD.
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Finally, click on the Record button to start recording the data to disc. Easy CD
Creator displays the Record CD Setup dialog box. Select the target Drive and the
Number of Copies to record. Set the Write Speed based on the speed of your
drive, the rating of your disc media, and your experience with recording. You may
want to experiment with using lower speeds for greater reliability and compatibili-
ty, especially if you are using unbranded media or need the discs to be readable on
a wide array of possible players.

You can check Copy to hard drive first to create a disk image file before writing,
but this is typically not required on current machines. Make sure Buffer underrun
protection is checked; most PCs and CD drives should then be fast enough to
record your disc without the glitches that used to plague the recording process.

Click on the Options button to set the Record Options. It is a good idea to use
Test and Record CD to check the burning process the first few times you use it.
Use the Record Method to specify when you finish recording. Use Disk-at-Once to
record the entire disc in one operation, and close it so that it can be read on other
platforms. Use Track-at-Once to record data in multiple operations and to finalize
each recording session. When the disc is full, you can finalize and close the CD.

Writing Files with DirectCD
Besides using Windows desktop recording or Easy CD Creator to write entire
collections of data in one recording session, Roxio DirectCD offers an alternate
approach that makes the CD act like a normal disk drive, so you can drag and
drop individual files to write them to disc. DirectCD implements a packet-writing
technique that enables you to write files to the disc and then come back later to
add additional files. It does this at the cost of compatibility with other format stan-
dards, however. After you finish writing to a disk using DirectCD, you then can
modify the disc to be compatible with either the UDF or the ISO 9660 format. 

Depending on your system configuration, the version of DirectCD installed on
your system, and the DirectCD options settings, it can automatically launch when
you insert a blank disc and offer to close a disc when you eject it.

To use a recordable CD or DVD disc with DirectCD, you need to first format it
for DirectCD access. Use the DirectCD Format Utility to format a blank CD for
drag-and-drop recording (see Figure 5.8). Click on the Format CD button to begin
the format, which can be completed in less than a minute for a blank CD-R. A full
format of a CD-RW with a check of the format can take 15 to 60 minutes,
depending on the speed of your drive.
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When the format is complete, the disc appears in Windows Explorer, just like any
other disc. You can drag files onto it, delete files, and use it in Save File dialog
boxes within your applications. You also can rename, move, and delete files. The
only differences are that access to the disc is slower than a hard disk; and when
you delete a file on a CD-R, the file goes away, but the space that it occupied is
not freed for use by other files.

Ejecting a DirectCD Disc
When you eject a recordable disc formatted for use with DirectCD, it displays the
Eject Options dialog box (see Figure 5.9). You can either choose Leave as Is to
keep the disk in the DirectCD state so that it can continue being used for
DirectCD access, or choose Close to Read on Any Computer to reformat it 
to be accessible on standard CD-ROM or DVD-ROM drives. 

If you are using CD-RW media, when ejected it can be read by CD-RW and most
current CD-ROM drives. When reinserted, you can still continue to use it with
DirectCD drag-and-drop access.

FIGURE 5.8

Use the DirectCD
Format Utility to
format a blank,
recordable CD or
DVD for drag-and-
drop access.
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Importing and Browsing Pictures 
in Windows XP
Windows XP has built-in support for connecting to most USB digital cameras.
Importing photos is as easy as connecting the camera like a removable disk,
browsing the stored pictures on it in Windows Explorer, and then copying the
photo files to your hard disk.

Windows XP provides the My Pictures folder for storing and organizing your pho-
tos. Windows Explorer also includes enhanced support for browsing folders of pic-
tures, with options in the Taskbar that include viewing the folder as a slide show. 

You can then use the Windows Paint accessory or other third-party tools to edit
your images.

Connecting and Disconnecting Your 
USB Camera
Windows XP has built-in support for connecting to most USB digital cameras. 

First, connect your camera to the USB port on your computer and then turn the
camera on in playback mode. Windows automatically recognizes the device and
mounts it as a new external disk drive on your system. You can then browse the
photo files stored in your camera’s memory as if they were stored on a disk drive
attached to your computer.

FIGURE 5.9

Use the DirectCD
Eject Options dialog
box to reformat and
close the disc to be

read on standard
data drives.
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The first time you connect your camera, Windows XP displays a Found New
Hardware notification in the Taskbar at the bottom right of the display.

When the camera is connected, Windows adds a Safely Remove Hardware icon
to the Taskbar. Before you disconnect or power off your camera, you should use
this to dismount the camera and associated disk from your system. This prevents
the danger of breaking the electrical connection while the computer and the cam-
era are in the middle of an operation.

To prepare to disconnect the camera, click on the Safely Remove Hardware icon
and select Safely Remove Hardware. Windows dismounts the disk and then dis-
plays a Safe to Remove Hardware notification (see Figure 5.10). You then can dis-
connect your camera safely. Windows uses this same process when mounting and
disconnecting other devices, such as external drives—both USB and FireWire.

FIGURE 5.10

Use the Safely
Remove Hardware
icon to dismount the
camera from your
system before
disconnecting it.

Accessing Your USB Camera
When your digital camera is connected and mounted on your system as a disk,
you can access its contents like any other disk drive. Open a Windows Explorer
window from My Computer and then browse the contents of the camera disk.
Windows recognizes its contents as a collection of pictures, and displays the files
as photo thumbnails (see Figure 5.11).

Explorer provides a viewer interface with buttons to step through the photos; 
it also provides options under Picture Tasks, including viewing the photos as a 
slide show. 

The photos are still stored on the digital camera, however, and accessed through
the relatively slow USB connection. You should copy the files to your hard drive to
save and edit—typically into the My Pictures folder. You then can delete the pictures
stored in the camera.
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Similarly, you can import photos from other cameras using USB readers for their
removable media. You can acquire images yourself from a scanner, or have film
processed and digitized and then returned on a CD or posted on the web for you
to download.

Organizing Your Photos and the 
My Pictures Folder
Windows provides standard folders that you can use to organize your files—
including the My Documents folder for various word processing, spreadsheet, and
other kinds of documents. Windows XP extends this support by providing a My
Pictures folder within My Documents that can be used to organize pictures. Under
Windows XP, each user login has its own copy of the My Documents folder.

When you use Windows Explorer to view the My Pictures folder (or actually any
folder with image files), Explorer enhances the window for viewing pictures. This is
shown by the faint photo watermark at the bottom-right corner of the Explorer
window. Of course, because your pictures are simply files, all the normal file-
browsing features and actions also are available.

FIGURE 5.11

Use Windows
Explorer to browse

the photos stored on
your digital camera.
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Use the View menu to select the viewing mode for your files. Choose Filmstrip to
display a viewer to step through your files (refer to Figure 5.11). Choose
Thumbnails to view thumbnails of each picture and folders with small thumbnails
of some of the images inside them embossed on their covers (see Figure 5.12).

FIGURE 5.12

Use the Windows
Explorer View
options to browse
the My Pictures
folder.

Click on the Folders button to alternate the left Explorer Bar panel between a
hierarchical list of folders and the context-sensitive Taskbar. The Taskbar includes
specific Picture Tasks for photo files, general File and Folder Tasks for all files,
Other Places, and Details of the currently selected file.

Under Picture Tasks, you can view the contents of any folder as a slide show, and
even order prints of your photos online.

You also can right-click on a file to see a pop-up menu with both general Explorer
actions and picture-specific actions. Choose Properties to examine the image file
characteristics. Select the Summary tab, and click on the Advanced button to dis-
play the information that the camera stored with each photo, including lens type
and exposure time (see Figure 5.13). 
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You can organize your pictures using folders and shortcuts. For example, you
might keep all your vacation photos in a Vacation folder, with subfolders for each
year. If you decide that you want to create a highlights slide show, you could select
and Copy photos of interest, move to a Highlights folder, and then use Paste
Shortcut to create shortcuts to the originals in the Highlights folder. Your originals
remain in place, and the shortcuts take up little space.

If you choose to store photo files in other folders besides My Pictures, Windows
Explorer can provide the same kinds of View options as Filmstrip or Thumbnails.
You also can customize a folder as a Photo Album by using the Customize tab in
its Properties dialog box.

DV Video Editing with Windows 
Movie Maker
As with digital photos and the My Pictures folder, Windows XP provides built-in
support for browsing and viewing video files in the My Videos folder.

FIGURE 5.13

Display the Properties
dialog box for the

photo file to review
the information on

how each photo 
was shot.
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Windows also includes the Windows Movie Maker application to capture, edit,
and export video from DV digital cameras over a FireWire/IEEE 1394 port. You
can edit and save movies, download them to a portable device, and share them
over the web.

Browsing Video in the My Video Folder
Just as the My Pictures folder is enhanced with built-in photo-viewing capabilities,
Windows XP also includes a My Video folder enhanced for browsing video clips
(see Figure 5.14). As with pictures, Windows Explorer automatically provides these
enhancements for any folder containing video files, as shown by the filmstrip
watermark at the bottom-right corner of the Explorer window.

The My Video folder works much like the My Pictures folder, with a thumbnail for
each file displaying a single frame of the video sequence. You can organize your
videos using the same methods you use for your pictures—including renaming,
moving, copying, publishing to the web, emailing, and deleting. You can select and
play back single videos or all the videos in a folder. 

FIGURE 5.14

Windows Explorer
provides enhanced
capabilities for
viewing the My
Videos folder.
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About Windows Movie Maker
Windows Movie Maker is the basic video-editing tool built into recent versions of
Windows. It is normally found under Accessories in the Start menu. With Movie
Maker for Windows XP, you can import media files, capture video from DV cam-
corders or record from other devices, and import and edit clips into projects; you
can then export your movie to a video file, copy it to a portable device, or post it
to a web site.

Capturing from DV with Windows Movie Maker
A Movie Maker project is built around a collection of media material. You can
import video, audio, and still images in a variety of formats. You also can capture
video, audio, and stills from any available input devices, including digital and analog
sources. Movie Maker can record to files from digital camcorders with FireWire or
USB connections. 

When you attach and turn on your digital camcorder, Windows recognizes the
type of device and adds it as an icon to the Taskbar. Note that unlike with digital
cameras, a camcorder is not treated like a disk device, so you cannot browse its
contents in Windows Explorer.

To start capturing, pull down the File menu and choose Record to display the
Record dialog box (see Figure 5.15). Use the Change Device button to select
between multiple input devices as available on your system, and the available
options change according to the selected device. Use the Record drop-down
menu to select between recording Video only, Audio only, or Video and Audio.

FIGURE 5.15

Use the Record
dialog box in

Windows Movie
Maker to capture

input material from a
DV camcorder.
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You also can set a Record time limit and use the Create Clips check box to have
Movie Maker split the input recording into individual clips based on recognizing
scene transitions.

Movie Maker always records files in Windows Media format. Also use the Setting
drop-down menu to choose the compression type: Low, Medium, or High Quality;
or choose Other to select specific target data rates for dial-up to broadband web
streaming, or for PDA devices.

For digital camcorders connected by a FireWire interface, you can use the play
controls to play the tape and position it to the start of the material that you want
to control.

Finally, click on Record to start recording to disk. Press Stop to finish recording 
the clip.

In the Timeline view, you also can record audio clips by pulling down the File menu
and choosing Record Narration. The audio source can be any source on your
computer, including microphone or line input, an audio CD, or the output of your
sound mixer. 

If you already have audio or video clips from another source in your system, you
can use the Import menu item to add them to your collection to use in the movie.

Editing Your Movie
When you have imported and recorded your clip collection, you then assemble
your movie into the Storyboard area at the bottom of the window. You also can
use the View menu to switch to a Timeline view to precisely control the overlap
of the different streams (see Figure 5.16). 

As you work with clips, you can edit their order by dragging them on the
Storyboard or Timeline. Use the Clip menu to Trim, Split, and Combine adjacent
clips. Select Set Start Trim Point, and a set of movable sliders appears at each end
of the clip. Move the sliders to set the trim points, and the video display changes
to display the frame at the current trim point.

To create a transition between adjacent clips, drag the second clip so that it over-
laps the first. Movie Maker automatically creates a dissolve transition from the first
clip to the second for the duration of the overlap. Use the Zoom buttons on the
left of the Timeline to zoom in and out for more control.
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As you edit, you can use the play controls under the video window to preview the
entire duration of the assembled clips, or drag the slider to move to a specific sec-
tion of the movie. You also can use the Play menu options to work your way
through the movie scene by scene or even frame by frame.

Exporting Your Movie
After previewing your movie, you can export it to disk, and play and share it by
writing it to CD or copying it to a portable device, such as a PocketPC handheld.
You also can save a movie directly to a web site, or send it by email.

Pull down the File menu, and choose Save Movie to use the Save Movie dialog box
to select the output video file format (see Figure 5.17). You can export to a
Windows Media file and choose the compression format and target data rate, or
save the movie as a DV-AVI file in DV NTSC or PAL format. You also can supply
properties information that can be displayed in the browser window for the My
Videos folder. After the video clip has been saved, you can use Windows Media
Player to play back the movie. 

You can also use the Send Movie to menu option to send the movie to a web
server or via email. Especially for email, make sure you compress it to a reason-
ably small size.

FIGURE 5.16

Use the Timeline
display for more

precise control while
editing your movie.
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Summary
This chapter provided a walkthrough for using Windows XP on a PC to import,
organize, edit, and export digital media. On a system with the appropriate USB
and FireWire ports and recordable disc burners, you can record data files to CD
and DVD; import and browse digital photos; and import, edit, and save video and
audio movies.

Windows XP provides built-in support for accessing digital cameras via the USB
port and digital camcorders via the FireWire (and USB ports), as well as capturing
from other analog video and audio devices using compatible hardware. Windows
Explorer also provides enhancements for browsing and viewing folders of still
image files and motion video clips. 

You also can use Windows Movie Maker to perform basic video editing to prepare
clips for importing into DVD authoring tools. 

Now that you have explored how to connect to digital media hardware devices and
access them on the Macintosh and under Windows, you can move on to Part II,
“Exploring DVDs on Your Computer” to play movies on DVD and explore how
they were designed.

You can then use these capabilities to import and prepare your own video, audio,
and still image media content, and use the tools described in Part III, “Automated
DVD Authoring” to quickly create your own DVD production, complete with
navigational menus and slide shows.

FIGURE 5.17

Use the Save Movie
dialog box to export
your movie in
Windows Media or
DV-AVI format.
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